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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 1993-2007 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Microsoft®, Windows®, Windows NT®, and Windows® XP are U.S. registered trademarks of Microsoft 
Corporation.  

Windows VistaTM is either a registered trademark or trademark of Microsoft Corporation in the United 
States and/or other countries. 

Java™ is a US trademark of Sun Microsystems, Inc. 

UNIX® is a registered trademark of The Open Group. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated. 

Pentium® is a registered trademark of Intel Corporation or its subsidiaries in the United States and other 
countries. 

For additional trademark information, see the Chapter 8, “Copyright,” in the HP OpenView Enterprise 
Discovery Reference Guide.  
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Support 

Peregrine Product Support 

You can obtain support information for products formerly produced by Peregrine as follows: 

• If you work with an HP OpenView Services Integrator (SVI) partner 
(www.hp.com/managementsoftware/svi_partner_list), contact your SVI agent. 

• If you have an active HP OpenView support contract, visit the HP OpenView Support site and use the 
Self-Solve Knowledge Search to find answers to technical questions. 

• For the latest information about support processes and tools available for products formerly produced by 
Peregrine, we encourage you to visit the HP-Peregrine Software Support web site at: 
www.hp.com/managementsoftware/peregrine_support 
where you can download the Customer Support Handbook. 

• Contact your HP Sales Representative if you have additional questions. 

HP OpenView Support 

You can visit the HP OpenView Support web site at: 

www.hp.com/managementsoftware/support 

HP OpenView online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.   

To find more information about access levels, go to:  
www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to: 
www.managementsoftware.hp.com/passport-registration.html
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HP OpenView Enterprise Discovery 

Release Notes 
Software version: 2.1.2 / February 2007 

This document provides an overview of the changes made to Enterprise Discovery for version 2.1.2. It 
contains important information not included in the manuals or in online help. 

In This Version 

New Features 

Documentation Updates 

Installation Notes 

Enhancements and Fixes 

Known Problems, Limitations, and Workarounds 
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In This Version 

Introduction 

These release notes are for Enterprise Discovery 2.1.2. This new version of Enterprise Discovery is the 
upgrade path for users of Enterprise Discovery 2.1.1, 2.1, 2.0.x, and users of Network Discovery 5.2.5.  

If you want to see what features have been introduced in previous versions of Enterprise Discovery 
(including versions 2.0, 2.0.1, 2.0.2, 2.0.3, 2.0.4, 2.1, and 2.1.1),  you can read the Release Notes for those 
versions, available on your installation CD under bin\documentation.  

License Schema 

Each Enterprise Discovery server can collect data for a maximum of 50,000 devices or 100,000 ports 
(whichever comes first). An Enterprise Discovery Aggregator can support 50 servers and up to 500,000 
devices. 

Updated third party components 

Java runtime environment (JRE) upgraded from version 1.4.2_12 to version 1.4.2_13 
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New Features  
The following features are available in this version of Enterprise Discovery: 

Scanner and Agent Support for Windows Vista 

Enterprise Discovery now fully supports Windows Vista on both 32-bit and 64-bit platforms for the agents, 
scanner and software utilization plug-in. This means that Windows Vista machines in your network are now 
accurately discovered and can be automatically inventoried. 

Note: The Enterprise Discovery server itself and the client installation are not yet supported and must be 
installed on an earlier version of Windows (see Software and Hardware requirements below). 

Security Updates  

To eliminate a security vulnerability, Enterprise Discovery now installs the Java runtime environment 
(JRE) version 1.4.2_13. 

Windows Scanner Optimization 

The Windows scanner binary is now approximately 70Kbytes smaller. 

Support for Linux on 64-bit platforms (in 32-bit mode)  

Using the 32-bit Linux scanner, Enterprise Discovery can now discover and automatically inventory 64-bit 
Linux systems running on AMD64/EM64T processors in 32-bit compatibility mode.  

 

Obsolete Features 

All features in 2.1.1 are currently supported in release 2.1.2. 
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

Version number, which indicates the software version. 

Publish date, which changes each time the document is updated. 

 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 In the Product list, click the product name (for example, Enterprise Discovery). 

2 In the Version list, click the version number. 

3 In the OS list, click the operating system type. 

4 In the document list, click the document title. 

5 To retrieve the document, click Open or Download. 

 

 To view files in PDF format (*.pdf), Adobe® Acrobat® Reader must be installed on your 
system. To download the Adobe Acrobat Reader, go to the following URL: 

www.adobe.com 

 

The following PDF documents are available in the Enterprise Discovery user interface: 

Planning Guide  

Installation and Initial Setup Guide 

Configuration and Customization Guide 

Network Data Analysis Guide 

Scan Data Analysis Guide 

Reference Guide 

Migrating from Network Discovery 

One additional PDF file is available on the install CD at bin/documentation: 

Legacy Scanners 

None of these guides have been reissued for release 2.1.2. 

 

The following document is available in HTML format, through the Enterprise Discovery client (Start > All 
Programs > HP OpenView > Enterprise Discovery 2.1.2 > Documentation) 

Data Collected by the Scanner 
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Installation Notes 
Installation requirements, as well as instructions for installing Enterprise Discovery, are documented in the 
Installation and Initial Setup Guide provided in Adobe Acrobat (.pdf) format.  

If you are upgrading from a previous version, you need to follow these steps: 

1 If you have created your own User SAIs, make sure you back them up manually before uninstalling 
Enterprise Discovery.   

2 Save an external backup of your data, if necessary.  

3 Uninstall the old version of Enterprise Discovery, using the Windows “Add/Remove Programs” feature.  

4 Depending on the version you are upgrading from, delete one of the following directories from the server:  
 
Version 2.0.x: C:\Program Files\Peregrine\Enterprise Discovery\*.* 
 
Version 2.1.0: C:\Program Files\HP OpenView\Enterprise Discovery\2.1.* 

5 Reboot the server before you install the new version.  

The uninstall will not delete the Enterprise Discovery Data directory. Rebooting the server will ensure 
that all parts of Enterprise Discovery are removed. 

6 Install the new version and follow the steps in the Installation and Initial Setup Guide. 

If you changed the default location of the Data directory when you installed a previous version, you need 
to ensure that you use the same location when you install the new version.  

  

 
Perl, MySQL, Tomcat and Apache are standard parts of the Enterprise Discovery, included with 
each server installation. If you have these components installed already, make sure to remove 
them before installing Enterprise Discovery. You may NOT substitute any other technologies in 
place of the standard installation. 
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Software and Hardware Requirements 

The Enterprise Discovery server can be installed on Windows 2003 Server SP1. (Windows® XP SP2 is also 
compatible, but should only be used for trial or demo installations.) 

The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6MB under Program Files 
for the Enterprise Discovery installation.  

Table 1 - Hardware Requirements 

Devices Ports Aggregation Inventory Topology 
Memory 
(GB) CPU* 

Disk 
(GB) 

5,000 30,000   x    1.5 
1 CPU 
2.4GHz 25 

5,000 30,000     x  1.5** 

1 CPU 
2.8 GHz 
hyperthreading 15 

5,000 30,000   x x  2** 

1 CPU 
2.8 GHz 
hyperthreading 35 

15,000 90,000   x    2 

2 CPUs 
3 GHz 
hyperthreading 70 

15,000 90,000     x  3.5 

2 CPUs 
3 GHz 
hyperthreading 35 

15,000 90,000   x x 4  

2 CPUs 
3 GHz 
hyperthreading 100 

50,000 100,000   x   3 

2 CPUs 
3.6 GHz 
hyperthreading 200 

50,000 100,000     x 4 

2 CPUs 
3.6 GHz 
hyperthreading 50 

50,000 100,000   x x 5 

2 CPUs 
3.6 GHz 
hyperthreading 240 

50,000 n/a x n/a n/a 2  

2 CPUs 
3 GHz 
hyperthreading 10 

500,000 n/a x n/a n/a  3 

2 CPUs 
3.6 GHz 
hyperthreading 50 

* Newer CPUs may have lower frequency but higher performance than those shown in the table. 

** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

 

 
These requirements are running one XML Enricher. If you plan to run two XML Enrichers, more 
CPUs may be required. 
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These calculations have been tested as scenarios for maximum disk size on the server. For the Inventory 
license, this includes: 

Backup Scan Files is enabled (on average, each scan file is 250KB) 

Generate MIF Files is enabled  

Delta scanning is enabled 

Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

Statistic Export is enabled (CSV files) 

200 users, with each user account saving 10 map configurations files 

Space required for two backups (one stored backup, and one “in process” backup) 

The Enterprise Discovery client has the following requirements: 

Operating System Windows 2000, XP, or 2003 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files.) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

1.4.2 or 1.5 
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Enhancements and Fixes 
The following items (identified by error tracking number) were added or fixed in the current software 
release. Table 2 lists enhancements to existing features or behavior; Table 3 lists problems that were fixed. 

Table 2 – Enhancements 

Number Location Enhancement Description 

16513 Windows Scanner The Win32 scanner supports a new feature of 
Windows Vista – symbolic links to files and 
directories. The scanner now handles them 
properly just as in UNIX, where they were 
supported in earlier versions of Enterprise 
Discovery. 

17097 Windows Scanner Operating system detection of the Win32 scanner 
has been improved and now supports all editions of 
Windows Vista, Windows 2003 Server R2, and 
Windows Storage Server. 

17167 Linux Scanner Linux 64-bit (in 32-bit compatibility mode) for 
AMD64 and EMT64 processors is now supported. 

 

Table 3 - Problems Fixed 

Number Location Fix Description 

16723 System Monitor If the system monitor service is manually stopped 
during the Enterprise Discovery startup sequence, 
it can now be consistently started again.  

16807 Solaris Scanner The Solaris scanner now correctly identifies  
Fujitsu Siemens SPARC64 V processors. 

16834 Linux Scanner The installed application hardware detection 
process in the Linux scanner has been optimized 
for improved performance. 

16845 Administration > Network 
Configuration > Agent 
Property Groups 

If the All Off agent property group is selected for a 
particular IP range, the Enterprise Discovery 
server can still communicate with devices in any 
sub-ranges that are assigned to other agent 
property groups. 

16887 SAI Editor A problem with re-loading externally modified SAI 
files has been resolved in the SAI Editor. 

16897 System Monitor In the Windows Services tool, you can now restart 
the system monitor using the Restart option in the 
right-click shortcut menu. 
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Number Location Fix Description 

16925 Software Utilization agent 
plug-in 

On all supported locales, the Scan Data Viewer 
now correctly shows complete software application 
data for all scanned devices. 

16950 Aggregator Data Transfer The location of a device in the packaging hierarchy 
in the prime map configuration for that device is 
now transferred from the Real-time database to 
the Reports database. 

16951 Scheduler The trash and purge operation is now scheduled 
properly for all license combinations, including 
when the Topology license is not present.  

16974 Windows Scanner The Win32 scanner can now collect registry extract 
values that are of REG_DWORD and 
REG_BINARY type. 

16978 UNIX Scanners Scanners now prevent invalid control characters 
from appearing in the scan file’s XML data. 

16992 Web UI The UI shortcuts for Device Manager, Line 
Manager, Port Manager, and Service Analyzer now 
open correctly and consistently for all device types, 
lines, and ports specified. 

17009 Database If MySQL crashes on the Enterprise Discovery 
server and is then restarted, all active devices are 
now listed correctly in the Device Visibility column 
of the Licensed Devices table. 

17017 Aggregator Importing events into the aggregate database now 
works correctly and consistently. 
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Number Location Fix Description 

16841, 17018, 17019, 
17081, 17049, 17089 

Internationalization 
 

Asset Questionnaire 
 
 

Web UI 
 

Web UI 
 
 

Windows Agent 
 
 
 
 

Web UI 
 

Reports 

The following internationalization issues have 
been resolved: 

Previously, the Asset Questionnaire could not 
import values with Chinese or Korean characters. 
This problem has been corrected. 

The online help is now displayed correctly when a 
Korean locale is specified.  

Japanese and Korean characters now display 
correctly in the Device Manager and throughout 
the UI. 

The Windows agent is now correctly deployed 
when non-ASCII accented characters, such as 
those that appear in European and Korean 
character sets, appear in the user name or 
password for the Deployment account. 

The UI now properly handles  non-ASCII 
characters within dates for all supported locales. 

The date and time shown on reports is now 
displayed correctly in Korean and Chinese locales. 

17024 Server > Administration > 
Agent Deployment 
Accounts > Deployment 
account properties 

The label for the second Password field was 
changed to “Password (again)” to make its meaning 
more clear. 

17025 Authorization Access privileges according to user account type 
are now more strictly enforced. 

17035 Installation The Enterprise Discovery installer now performs a 
more thorough check for existing versions of Perl. 
If any are found, a warning is displayed. 

17041 Windows Scanner Software utilization data can now be gathered for a 
system when a user is logged in to that system.  

17042 HP-UX Scanner HP/PA and PowerPC executables are now correctly 
detected. 

17059 Scanners The scanners now properly process binary files 
that have the same starting bytes as gzip 
compressed files. 

17068 Scanners The –scandays command line parameter works 
properly now. 

17090 Administration > System 
Configuration > Server 
passwords 

After you change one or more of the password 
criteria for the Enterprise Discovery server, the 
change takes place immediately. 
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Number Location Fix Description 

17105 Windows Scanner Scanner can now properly detect dual core Intel 
CPUs on Windows systems. 

17107 Web UI The tools available in the tree in the left 
navigation panel are also available in the menu on 
the right side of the main Server home page in the 
Enterprise Discovery UI. 

17115 Device Manager The scanner and agent log files are now available 
for the itmanager account type as well as the 
admin account type. 

17151 XML Enricher The maximum memory usage parameter for the 
XML Enricher was increased from 128 MBytes to 
384 MBytes. This allows a larger number of SAI 
files to be loaded. 

17148, 17149 UNIX Scanners The UNIX scanners have been enhanced to provide 
improved model and serial number detection. 

17191 Notifications Event notifications to be sent by alphanumeric 
page or e-mail are now consistently generated.  
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Known Problems, Limitations, and Workarounds 

Agents 

The agent upgrade process on Solaris 9 may take a long time (SCR# 16663).  

MAC OS X agent upgrade may not work when initial agent was installed and run from shell (SCR# 16828).  

Scanners 

In Manual Deployment mode, the UNIX scanner will not save offsite scan files to an FTP server when the 
user name is specified in the form domain name/user name (SCR# 12893). 

The scanners cannot open some files in non-English operating systems (SCR# 16462).  

Some files excluded in .override.ini are still being scanned (SCR# 15766).  

In the Scan Command Line /O Switch, the “/O” should be “/o” (lower case) (SCR# 15852).  

Automounts are being scanned in HP-UX and Linux systems (SCR# 15950).  

Pressing Ctrl-C sometimes causes access violations for the Win32 scanner (SCR# 16780).  

The Solaris scanner does not collect Physical Disk Data for Solaris 8 systems (SCR# 16796).  

Cache associativity on Solaris is reported as 'unknown' (SCR# 16831).  

Time Zone not reported correctly on Linux 2.2 and 2.6 (SCR# 16836).  

Disabling the operating system hardware test results in scanner not running (SCR# 16861). 

Network card detection on AIX systems sometimes reports errors (SCR #16934).  
In some cases, user specific environment variables are not collected by the scanner (SCR #17103).  

Analysis Workbench 

In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the "Treat field as a 
File Name" option is selected, the "Replace invalid characters with" field must be populated as well, even if 
the "Delete invalid characters" option is selected instead.  Otherwise, the “The file ‘Replace invalid 
characters with’ may not be empty” error dialog appears (SCR #15827): 

For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (SCR# 16838).  

Stored files export from AW failing (SCR# 16896). 

Server Installation 

Server uninstall will report a “Fatal error” if the Favorites in the Registry contains an invalid path (SCR# 
15303).  

After an uninstall, the branding registry keys are leftover (SCR# 15507).  

When uninstalling Enterprise Discovery on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (SCR# 14370).  

Enterprise Discovery with a Network Topology license should not be installed on VMware (SCR# 16524). 
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Non-ASCII characters used in data directory path name can cause problems during the installation (SCR# 
16520).  

Unattended installation using MSIEXEC causes the installation to become corrupt if this is not the first 
installation on the server (SCR# 16785).  

Client Installation 

After uninstalling the client, the menu items will still appear under the Windows Start menu (SCR# 16437). 

Server 

If your server has another service using port 80, the HP OpenView Discovery Apache service will not run 
properly (SCR# 14808).  

If there is a MySQL query that takes too long, Enterprise Discovery will not function properly and you may 
need to restart System Monitor to recover (SCR# 13964).  

An older openssl DLLs in the system PATH can affect the Enterprise Discovery Apache server and perl 
engines (SCR#16318). 

The user scan files (SAIs) converted from version 2.0.x contain no file data (SCR #17164). 

Web User Interface 

Administration 

Depending on the licenses, the "Resource/ Environment manage" property in Network Configuration may 
not have any effect (SCR# 14388). 

In the "Account properties" page, changing the "Default Device Manager panel" or "Default Port Manager 
panel" to "Statistics" does not work (SCR# 16853). 

Reports 

Sometimes web pages under Reports do not completely render or print source code in Mozilla Firefox. Use 
the refresh button (SCR# 13803).  

Web Asset Questionnaire 

A blank numeric field should be accepted if it is not a required field (SCR# 16279).  

The UI may show non-printable characters in text fields (SCR# 16285).  

Miscellaneous 

The "Server Management" page does not report correctly the server memory if the value is above 4GB (SCR# 
16840). 

Applets 

In the Folder tab of the MIB Browser the Object column does not sort properly (SCR# 16814).  
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Overwriting the OID field could sometimes kill the MIB Browser session (SCR# 16825).  

The tree in the Scan Data Viewer will disappear when clicking on the "Go up one level in the tree hierarchy" 
button when the data for a main level folder is displayed (SCR# 16866).  

The Event Browser will fail to display "SNMP Write by MIB OID" events if the applet is using JRE version 
1.5.x (SCR# 16876). 

Using the “&” character in package names can cause the Network Map to disconnect (SCR #17102). 

Licensing 

Alarms License  

Alarms-related items are not always hidden (SCR# 16041). 

Internationalization 

The product does not work when installed in a directory with non-ASCII characters in the path. Enterprise 
Discovery should only be installed and used with ASCII directory names (SCR #17016).  

The Scanner Generator cannot be launched when the product is installed in a directory with non-ASCII 
characters in the path (SCR #17104). 

The Scanner Generator does not work properly when non-ASCII characters are used in various fields (SCR 
#17060, #17061, #17062, #17064, #17069). 

Reports do not use the language options configured in the operating system and will always format the dates 
in English (SCR #17140).  

The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (SCR #17180). 
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